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I. Consulting Situation 
Organization 
Central Academy began in 1994 and offers elementary school education for kindergarten through 
second grade. It is an independent organization, yet it is closely affiliated with Central Baptist 
Church in that they share resources. Central Academy’s mission is to “provide an atmosphere 
whereby children of all races will receive not just academic instruction but also Biblical based 
education.” Central Academy also strives to “assist [students] in discovering and developing their 
individual uniqueness and talents. In this regard CA will aide and establish learning experiences 
that will assist each student to become a maturing Christian Person, as well as a responsible and 
productive member of society.” 
 
Facilities 
Central Academy is housed in Central Baptist Church’s main building located at 2200 Wylie Ave 
in Pittsburgh, PA. This building is also used for the worship location of the church and as a 
facility for Central Outreach, which offers a daily lunch program. Specifically, Central Academy 
is located in the first floor portion of the building and has three classrooms, including the 
computer lab, and multipurpose space that serves as a cafeteria and play area. Also, Mrs. Roberts 
and Mrs. White both have there own offices. The building is equipped with high-speed Internet 
access, provided by Wireless Neighborhoods, and a computer lab with eight computers for the 
Academy. 

Programs 
Central Academy includes the standard K4 through second grade curriculum and has 24 students. 
One of CA’s primary educational resources is the curriculum provided by A Beka Books. CA 
also incorporates art, music, and P.E. into their curriculum.  

Staff 
The Academy Director, Donna Roberts (CP), is in charge of all administrative duties associated 
with the academy, such as payroll. Deon White is Mrs. Roberts’s secretary and Central 
Academy’s art instructor. She keeps track of attendance, final grades, students’ tuition, and 
performs other secretarial duties. Lastly, Central Academy employs two teachers, Ms. Murry who 
teaches 16 students in grades K4 and K5 and Mr. Paladin who teaches eight students in first and 
second grade. The staff has varying degrees of computer experience from, none at all to using 
computers for office tasks everyday. For example, Mrs. White frequently uses Microsoft Word to 
create calendars and letters that are distributed to parents and Mrs. Roberts frequently uses email. 
 
Technology Environment 
Both Mrs. Roberts and Mrs. White have PC’s, with Windows 98 and Windows 2000 respectively, 
and are connected to the Internet through the church’s network by a network server. The academy 
cluster computers specifications are as follows: OS: Windows 98, Pentium II, 32 – 64 MB of 
Memory, and 2.0 – 4.0 GB HD. At the beginning of the consulting situation the computers in the 
lab were not yet connected to the network. CA’s computers have a variety of software, but the 
programs they use most frequently by the staff are Microsoft Word, Excel, Internet Explorer, and 
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Quick Books. Only Mrs. Roberts currently has an email address through Hotmail. Besides 
computers, the office has two printers, a copier, and a fax machine. 

Technology Management 
Central Academy’s current technology management consists of a recently formed technology 
group affiliated with Central Baptist Church, which includes church administrators, trustees, and 
at least one member with significant technical expertise. The group has no technology plan and 
deals with technology issues on a case-by-case basis. The specifics of all the technology from a 
website affiliated with Central Baptist Church to basic computer maintenance for all Church 
related computers is solely the job of a part time personnel who comes in when needed In other 
words, the technology employee takes care of any technology related needs including 
maintenance, repair, and installation. As of date, the group has limited effectiveness, in that there 
are still pending technology concerns. 

Two aspects that are immediately noticeable about their technology environment are that 
individual computers lack any back up for their immediate files and many of the computers 
actively using the Internet lack anti-viral software. 

Technology Planning 
Currently, there is no technology planning in place in terms of a document or a committee 
although, if an opportunity were to arise the previously described technology group may handle 
it. 

Internal & External Communications 
Internal communication such as file sharing does not happen that often and critical information 
like the account records for Central Academy is backed up on floppy disk by Mrs. Roberts.  Any 
other internal communication takes place through email, by phone, or in person. External 
communication is achieved mostly through calendars, bulletins, letters, and by phone. For 
example, Central Academy sends out a calendar with all the events for a specific month. Central 
Baptist Church also has a static website, http://www.pghcentralbaptistchurch.org/, through which 
people can contact the church or find information about the Church. Also on this website is a 
section where Central Academy has information on its school policies and its mission statement  

Information Management 
Again, most of Central Academy’s important information, such as financial reports, is stored on 
individual computers. However, information for the students are stored by paper, because of the 
difficulty of the existing program, School of Tomorrow, which is suppose to help manage 
information, like tuition payments and attendance. This does not present a serious impediment to 
CA because of their small number of students. 

Consulting Tasks 
Consulting Task I:  Making the Computer Lab Ready for Use 
The computer lab at Central Academy had not yet to be set up, meaning that the computers were 
not hooked up and not connected to the Internet. However, shortly after the consulting task began, 
a Central Baptist Church technology employee completed the computer lab. Once the computers 
were available for use it was necessary to assess their capabilities and to further prepare them for 
use by the students. If the computers are not maintained properly then Central Academy could 
lose its computer resource and thusly be unable to use computers as a way to educate their 
students. This affects Central Academy’s mission because it effectively removes a viable area in 
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which their students could become skilled. Also, Internet safety measures such, as virus software 
and site blocking software not only protect the computers but the children as well. 
 
Approach: 

• Delete any unnecessary programs and files 
• Create user profiles necessary for connecting the network and sharing files 
• Orient Mrs. Roberts with various aspects of computer maintenance, including Window’s 

maintenance programs. 
• Connect a network printer 
• Make frequently accessed programs more easily accessible 
• Check and adjust monitor settings 
• Research and acquire virus software 
• Research and acquire Internet site restrictive software. 

 
Expected Outcomes 
As a result of this task it is expected that the computer lab will be maintained by Mrs. Roberts 
who will be able to perform some software based computer maintenance. Also, the computers 
will have only necessary programs and files, including those for virus protection other Internet 
utilities. 
 
Feasibility 
Because of the size of the computer lab (8 machines) this task is very feasible. Even though 
computer maintenance is an ongoing process it shouldn’t take more than a few weeks of the 
consulting period to clean up the computers and to show Mrs. Roberts the details of basic 
maintenance. Also, the consultant is already knowledgeable in this area and has used and 
preformed software and limited hardware based computer maintenance. 
 
Consulting Task II: Develop Curriculum for Students to Learn Computer Skills 
After the computer lab at the academy was finished, it was a great opportunity for Central 
Academy to meet its mission by schooling young students in the basics of computers, especially 
for students who do not have access to a computer otherwise. A computer based curriculum or 
one that utilizes computers would expose some students for the first time to an area that is critical 
for later education and will help others sharpen their skills. Computing is also an area that may 
interest students more than other subjects they have studied, again helping CA meet its mission of 
cultivating its students’ talents. 
 
Approach: 

• Find software not necessarily related to learning about computers that could be utilized 
such as games that teach reading or math skills 

• Involve teachers in developing a curriculum for the students and discuss any specific 
goals they may have for such a class 

• Learn what the students might be interested in or about areas where they could improve 
• Look for current activities that could somehow be incorporated into the computer lab 
• Coordinate with other local education programs in terms of resources and ideas 
• Have teachers become familiar with any acquired educational software. 
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Expected Outcomes 
Once the curriculum has been developed Central Academy will then be able to use computers to 
enhance the learning experience of its students. The teachers will be more familiar with 
computers and available resources and will able to lead their classes in an organized computer 
time. In addition, the teachers will also be able to change the curriculum as needed. The students 
will benefit by gaining further exposure to a necessary subject, which again meets Central 
Academy’s Mission of developing their students’ uniqueness and talents. 
 
Feasibility 
Acquainting Central Academy’s students with computers in a way that is effective is the reason 
Central Academy obtained computers and is an aspect of the curriculum that Mrs. Roberts desires 
to develop. Having achieved Internet connectivity the gathering of resources will be more easily 
facilitated. Since the task is not that heavily based on understanding technology, but rather its 
utilization, it is well within the expertise of the community partner and the consultant. 
 
II. Outcomes and Recommendations 
Consulting Task I: To make the computer lab ready for use 
The computer lab at Central Academy before the consulting task began was in a state of disuse. 
The donated computers had not yet been plugged in or hooked up to the network. Also, no 
software updates or regular maintenance had been done. These and other issues prevented the 
computer lab from being used by the students and effected Central Academy’s ability to meet its 
mission of developing their students’ individual talents. The consulting task was to fix the lab 
computers and in the process increase the technical skills of Mrs. Roberts so that she could 
perform essential computer maintenance.  
 
Outcomes: 

• Mrs. Roberts and the consultant removed unusable and irrelevant software. 
• Mrs. Roberts was shown and practiced finding files and folders using the search feature 

in windows. 
• Mrs. Roberts and the consultant added new software necessary to the lab including: 

Google Toolbar (installed for easy access to a search feature and a pop-up blocking 
option) and various educational software from installation disks. 

• One printer was added to the network and Mrs. Roberts and the consultant set the default 
printer settings on the individual computer lab computers. 

• Mrs. Roberts added password protection to restrict access to only Central Academy 
students and staff with the assistance of a Hill House employee. 

• Monitor settings were reviewed and adjusted by Mrs. Roberts and the consultant.  
• Troubleshooting and basic maintenance were reviewed including: Scan Disk, 

Defragmenting, and Disk Cleanup Applications. Mrs. Roberts is now able to use these 
applications.  

• A troubleshooting and basic computer maintenance tips guide was written by the 
consultant (See Appendix A) 
 

Through this task, the organization has gained an increased capacity to meet its mission. Mrs. 
Roberts is now capable of installing and uninstalling necessary software and can perform 
software based computer maintenance and troubleshooting. Now, if there is a basic problem with 
the lab or new necessary software, Mrs. Roberts is able to handle the situation without outside 
help. For example, Mrs. Roberts installed necessary popup blocking software on the computers 
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without assistance. In addition, in terms of basic problems, if a critical file is accidentally deleted 
and prevents a program from working Mrs. Roberts can now uninstall and reinstall the software. 
The outcome is sustainable because the skills acquired will be used on a regular basis, allowing 
Mrs. Roberts to grow in her confidence and problem solving skills concerning computers. Also, 
documents describing the procedures to install and uninstall software and descriptions of 
maintenance and troubleshooting have been made available to Mrs. Roberts. This task has 
currently not foster a new vision of how technology can be used, but as Central Academy 
continues to utilize computers it may allow them to see that computers are very manageable and 
that it doesn’t take a specialist to maintain an adequate level of technology. 
 
Recommendation: 
Create a Technology Plan 
It was apart of the original consulting task to create a technology plan for Central Academy, but 
due to time constraints and others tasks that took preference, the technology plan was never 
completed. The basis for the technology plan is to better able Central Academy to understand, 
use, and manage its current technology resources and to enable planning for problems and 
opportunities in the future. Even recently, one of the computers used by the secretary was 
infected by a virus and is now in a state of disuse. The computer was suppose to have virus 
software and if so needs to be configured to receive regular updates. Unfortunately, the computers 
vulnerability was unknown and its need for viral software left unchecked. Aspects like this could 
be included in a technology plan and prevent incidents in the future. Also, now that CA has a 
working computer lab, a technology plan could help complete and sustain new and current 
projects for the lab, helping CA meet its mission of developing its students’ talents. Also a central 
document that outlines for instance computer specifications can allow the CP to consult someone 
knowledgeable about computers with any questions they may have without the person ever 
having to visit Central Academy. Lastly, a technology will help with envisioning where 
technology can take CA beyond its current capacity. 
  
To start with, the technology plan Central Academy can first review other technology plans from 
similar schools. For instance the one already obtained during the consulting task, by Mrs. 
Roberts, is a good start. Second, when following the guidelines in the given resources try to 
involve the teachers at weekly staff meetings in ideas for future planning.  
 
The technology plan should at least include the following*: 

• How the organization currently uses technology 
• What aspects of technology CA would like to incorporate into the organization in the 

future 
• A budget for implementing the plan. 

 
These parts will allow CA to get a preliminary idea of technology resources and goals. As your 
technology plan grows and CA has a better understanding of the usefulness of technology 
planning it would be prudent include sections concerning the following. 
 
The steps to achieve a more comprehensive technology plan are as follows* 

• An organizational profile, which includes contextual details such as funding, community 
programs, staff, current technical environment, and Central Academy’s mission statement 

 Technical Environment should include: 
1. A current catalog of cluster computers and other technology resources including 

CP’s computer etc. 
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2. A list of the staff’s skills including things like word processing 
3. Check what the current specs are for new software and computers, i.e. a good 

computer today has “blank” amount of memory. This will be helpful for 
evaluating resources and assessing an appropriate time to upgrade. Another 
example of this is when will the newest version of windows come out? This year 
or two years from now? This is important because you wouldn’t necessarily want 
to buy a new computer or purchase an upgrade for your version of Windows if a 
new version is about to come out. 

4. Document all current software (check add remove/programs from the control 
panel to see a complete list.)  

 
• A vision that incorporates future plans into the mission statement and helps clarify and 

justify goals. 
• A list of projects and their purpose or impact and the steps needed to achieve them. 

Specifically, in the case of the computer lab CA could: 
1. List the curriculum for different grades and discuss how CA could use 

technology to reinforce those concepts. 
2. Documentation of any new idea and support for its implementation 
3. Write an outline/work plan for new technology again these can include things 

like upgrades, new computers, and intervals at which to purchase new software. 
4. Research and document any potential software. This is important because some 

of the educational software on the market is beyond the capability of CA’s 
current computers. 

5. Add a list of daily, weekly, monthly tasks to be preformed concerning technology 
an example of each is below. 

• Daily- Check the desktop for any missing program links 
• Weekly – Perform computer maintenance: like running Disk 

Cleanup, Update the webpage. 
• Monthly – Checking for any new educational software through 

online resources, making sure any virus software has been updated 
with new virus information. 

 
• A budget that outlines available funds, possible funds, and how the projects and intended 

purchases best fit the current and future operating budgets. Budgeting specifically for 
technology resources help makes technology a priority. 

• A timeline that incorporates both funding and project sub-objectives. This timeline is 
critical for planning, as it helps allocate resources such as staff, money, and time to 
achieving goals in the most productive way possible. 

• A schedule by which to update and annotate the tech-plan such that accomplishments can 
be documented, past shortcomings can be resolved and plans can be added. 

 
*Reports by Justin Sean Kenlon partnered with Citizens to Abolish Domestic Apartheid and a 
report by Jennifer Cerully and Agata Bugaj partnered with Hope Academy were consulted to 
create this recommendation. 
 
Resources: 
http://www.eTechPlanner.org/: a website by Pennsylvania Department of Education that steps 
you through the importance of technology plans and how to create one. 

http://www.eTechPlanner.org/
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http://www.nctp.com: National Center for Technology Planning, offers a guidebook for 
technology planning. 
http://www.progressivetech.org/Resources/index.htm: PTP offers a Technology Assessment 
Guide and a Technology Planning Guide. 
http://www.npower.org/tools/techplanning.htm: NPower has helpful documents on technology 
planning and a copy of Technology Literacy Benchmarks. 
http://www.techsoup.com/: Techsoup in their How-To section has a long list of articles related to 
technology planning. 
http://www.cnet.com, http://www.zdnet.com, http://www.dell.com, http://www.bestbuy.com, and 
http://www.circuitcity.com:  by looking at what these websites advertise, CA can get a sense for 
what the current standards of computers are. 
 
Consulting Task II: To develop a curriculum for computer lab usage 
Task II concerns assisting Central Academy in creating a curriculum in which they can utilize 
their computers. Specifically, finding and installing software pertaining to the subjects the 
students already learn and setting up a website for any computer related curriculum. Before the 
consulting task, the teachers had limited or no experience with computers and had not yet been 
familiarized with resources provided by the consultant. 
  
Outcomes: 

• Teachers and Mrs. Roberts are able to search for software and curriculum additions 
• Software can be installed that the students and teachers are able to use. Specifically, the 

teachers can install software and preview it before instructing students.  
• Teachers and Mrs. Roberts are able to adjust the computers to allow easy access to the 

software and to restrict setting changes, i.e. creating desktop icons and hiding folders 
• Most pertinent curriculum topics have computer related programs such as: reading 

comprehension, Reader Rabbit; math skills, Number Munchers 
• Teachers are able to setup software sharing over the network  
• A list of resources exists for educational software (free and purchasable) and for 

educational websites 
• Mrs. Roberts and the consultant created a webpage to display aspects of the computer 

curriculum, such as science related websites. 
• Mrs. Roberts was able to edit aspects of the webpage including adding and removing 

pictures, pages, and links. (Appendix B) 
• Mrs. Roberts was able to search for content to add to the webpage using various engines, 

including Google, Yahoo!, and MSN. 
 

Two outcomes that are not expected to be observed are all the teachers being proficient in the 
programs used and all teachers being able to use the Internet to find more educational software 
resources. Not all the teachers are proficient in basic computer skills, like opening programs and 
editing documents, therefore it was difficult to move beyond that level in the time that remained. 
However, Central Academy still will obtain an expanded capacity because some of their staff will 
be able to complete the tasks listed above. Personnel installing their own software and updating 
the webpage will sustain the outcome. This has come about by instructing personnel in all aspects 
of the consulting task and having them complete certain aspects individually, like installing there 
own software and looking for pertinent sites to the curriculum.  
 

http://www.nctp.com/
http://www.progressivetech.org/Resources/index.htm
http://www.npower.org/tools/techplanning.htm
http://www.techsoup.com/
http://www.cnet.com/
http://www.zdnet.com/
http://www.dell.com/
http://www.bestbuy.com/
http://www.circuitcity.com/
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Another outcome that has not been observed is a direct utilization of the website created during 
the consulting period. Central Baptist Church is in the process of changing their web host and 
hiring personnel to spearhead their website. As result CA’s webpage was never uploaded. 
Regardless, Mrs. Roberts has gained some familiarity with HTML that will allow her to 
administrate the site created once CBC has decided on a web host. 
 
Central Academy’s mission is to “assist parents… [in] educating their children… and to assist 
students in discovering and developing their individual uniqueness and talents.” The goals of the 
task help increase the teachers’ capacity to instruct their students in new and exciting ways; by 
exposing the students to a type of education, they never had before, leading them to explore 
computers. One of the problems that the outcome may not be sustainable is the personnel’s 
reluctance to try things on the computer and subsequently inhibiting their ability to increase their 
computer skills on their own. 
 
The outcome has supported a new vision of technology, because personnel have begun to 
envision greater things for the provided resources. Specifically, the webpage at first was to be a 
place just for students to go during any class time and find links to educational websites. Now, 
Mrs. Roberts has expanded the target of the website and hopes to put HW assignments on it have 
parents visit, and to organize specific sections of the page geared towards different subjects, like 
Math. 
 
Additional Recommendations: 
I.  Increase the capacity of Central Academy through additional Teacher Training 
Some teacher training was accomplished during the consulting period, but more could be done to 
expand the capacity of Central Academy, in terms of teacher proficiency with computers. A better 
learning environment can be achieved if teachers are comfortable with computers and can then 
assist the students with using software. Some of the teachers at Central Academy, due to limited 
instruction, have not had the opportunity to become familiar with basic aspects of computing. 
This leads to some students not being able to participate fully in computing which affects CA’s 
mission to explore and cultivate the talents of its individual students.  
 
Teacher training would also help with the sustainability of the outcomes in that teachers would be 
able to upkeep and expand the new curriculum and create better aspects for the following year. 
Additional training for one of the teachers already comfortable with computers will allow them to 
more effectively and confidently help other teachers and assist CA with their general technology 
needs.  
 
Additional training can come from spending more time on the computer, either by exploring 
settings or surfing the Internet. Central Academy could setup a weekly time where teachers can 
get together and work in the computer lab and surf the Internet for educational resources. For 
more formal training, taking a computer class in basic or higher-level computer skills would be 
ideal.  
 
Resources:  
http://www.ccac.edu: Community College of Allegheny County’s Lifetime learning section of 
their website offers a catalog that lists several courses related to computer instruction. They have 
program specific training such as Power Point classes and general courses such as introductory 
and advance computing. 
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http://www.carnegielibrary.org/locations/pccenter/classinfo.html: Carnegie Library of 
Pittsburgh's Computer Education division offers several classes at no to little cost. The classes at 
Carnegie Library range from introductory courses that involve learning skills like using the 
mouse to how to purchase a computer. The library also offers courses in the following programs 
and websites: Hotmail, Microsoft Word, Publisher, and PowerPoint. The contact information for 
all the classes is on the website. 
http://www.ymcaofpittsburgh.org/ymca/programs/ (Life Skills Development & Educational 
Programs: Educational) The Pittsburgh YMCA at its Penn Hills location offers a Microsoft 
computer training class, which would be good for anyone seeking to gain greater proficiency in 
simple computer tasks. 
http://computer.howstuffworks.com/: This website explains computers and various computer 
components. It may be helpful in understanding computers more in-depth. 
http://www.ckls.org/~crippel/computerlab/tutorials/index.html, 
http://www.ckls.org/~crippel/computerlab/tutorials/mouse/page1.html
The mouse aerobics section of this webpage (second link) is helpful for learning how to use the 
mouse. In addition, the other sections of the webpage offer tips on buying computers and 
maintenance. 
http://www.fgcu.edu/support/office2000/: This website offers free online guide to Microsoft 
Office 2000, including Word, Excel, PowerPoint, and FrontPage 
 http://www.microsoft.com/windows98/usingwindows/default.asp : Microsoft’s Windows 98 
page offers articles on computing including how to surf the Internet and email. 
 

 

 

 

 

 

 

 

 

 

 

 

About the Consultant: 
Stephanie Johnson is a sophomore Ethics, History, and Public Policy major and a 
Computer Science minor. She currently does not have any definite career plans, but is 
considering attending law school. 
 

http://www.ymcaofpittsburgh.org/ymca/programs/
http://computer.howstuffworks.com/
http://www.ckls.org/~crippel/computerlab/tutorials/index.html
http://www.ckls.org/~crippel/computerlab/tutorials/mouse/page1.html
http://www.fgcu.edu/support/office2000/
http://www.microsoft.com/windows98/default.asp
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Appendix A: 
 
Computing Tips 
Install:  
To install software from an installation disk insert the disk into the disk drive. Wait a minute. If it 
doesn’t automatically run, go to my Computer and click the D drive or if present the icon of the 
name of the program. Then find the .exe or the installation file and follow the instructions. If you 
download a program double click on the .exe file or if it came as a zip use MonkeyZip or WinZip 
program to extract the files and then click on the installation or .exe file. Follow the instructions. 
Note: If after you install a program if you experience problems with your computer you should 
try uninstalling. 
 
Uninstall: 
To uninstall a program go to Start Menu-> Settings -> Control Panel and then choose the 
“Add/Remove Programs” icon. You should get a list of programs on the computer. Select the one 
you no longer want and choose “remove”. Then follow whatever instructions are given. 
 
Disk Cleanup:  
Running disk clean up helps free necessary space on your computer so that you can store more 
files. To run disk cleanup go to: Start Menu -> Programs -> Accessories -> System Tools -> Disk 
Cleanup. After opening the program choose C: from the drop down menu if it is not already 
selected.  C just stands for the part of the computer where all the files are stored, also known as 
the hard drive. Once you have selected the drive i.e. C. review the checked boxes (none of the 
options remove files you need to keep) and accept the action. 
 
Disk Defragmenter:  
Disk Defragmenter reorganizations the information on the computer so that Windows can access 
it faster, thus making your computer run faster since Windows must access various information to 
run certain programs. To access Disk Defragmenter go to the same menu as Disk Cleanup and 
select Disk Defragmenter. Choose C as the drive to defragment.  Disk Defragmenter normally 
takes a while depending on the amount of files on the computer.  Sometimes Disk Defragmenter 
is unable to complete because of errors on the hard drive. If you receive such a message, run 
ScanDisk. 
 
ScanDisk:  
Through normal use of your computer, your hard disk drive can become cluttered and a bit 
messy. Also, folders can become cross-linked, file names can contain invalid or unknown 
characters or become damaged, and file names can become disassociated with their files. 
Scandisk can fix these and other problems for you. It's also a good idea to run Scandisk on a 
regular basis: once a week for Standard, and once a month for Thorough.  
To run disk cleanup go to: Start Menu -> Programs -> Accessories -> System Tools -> Scandisk. 
Click the drive you want to scan, and choose either the Standard or Thorough. Click Start. 

• The Standard test checks the files and folders on the selected drives for errors.  
• The Thorough test will give you further options. It performs the Standard test plus 

checks your hard disk drive for physical damage. You can even specify to scan areas of 
your disk containing only data files, or just the areas with system files, or both.  

• Both Standard and Thorough have a set of advanced options that help you to deal with 
lost file fragments, invalid files, and files that overlap the same disk space. You can also 
choose to keep a log file of what Scandisk finds.  
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(http://www.microsoft.com/windows98/usingwindows/maintaining/tips/beginner/scandisk.asp) 
 
Icons:  
To add an icon to the desktop right click on the program you want, mouse over to the “send to” 
option, and then click Desktop. An icon will appear on the desktop.  
 
Desktop: 
To change the desktop background right click on the desktop and choose “active desktop”. Then 
choose “Customize my Desktop” and click on the Desktop tab. Choose an appropriate picture 
from the list or go to the browse button to find a different file.  
 
Hiding Files and Folders:  
To hide a file right click the file and choose properties. On the dialog that appears look for and 
check option of “Hidden.” The folder should become faded or disappear depending on if the view 
settings are set to show hidden folders. If the folder does not disappear or you want to see hidden 
folders go to the “My Computer” and open a new window. Then on the View menu, click Folder 
Options and then click the View tab and select the Show all files check box or Hide files box. 
This information was found at 
http://www.microsoft.com/windows98/usingwindows/work/tips/advanced/. 
 
Internet Explorer Settings: To set the default homepage: click Tools on the tool bar for IE and 
then Internet options. You should see a text box that allows you to type in any webpage you like. 
 
Searching for Files: 
Click on the start button in the lower left hand corner of the desktop, then mouse over to Find and 
then choose “Files and Folders”. Before searching you should unhide folders all folders because 
hidden files and folders do not show up using the search method. 
 
Troubleshooting Tips 

• If a monitor, computer, or printer is not responding: Check the power cord. Make sure 
everything is securely plugged in to the machine and to the wall. 

• If the there’s a problem with the internet connectivity or with the network printer 
receiving a document you should follow similar steps as above, checking to see whether 
Ethernet cord is plugged securely into the computer and into the outlet. 

• If a program stops responding or the entire computer happens to freeze press 
Ctrl-Alt-Del and then choose the program that has “(not responding)” next to it or the 
program you want close and select the “end task” button. A moment later a confirm 
dialog box should appear and the “end task” button should be chosen. If the unresponsive 
program happens to be Explorer or after ending a program the computer is still 
unresponsive press Ctrl-Alt-Del twice to restart. 

 
Resources: 
http://www.computerhope.com/basic.htm Offers a list of troubleshooting documents for problems 
associated with several versions of Windows. 
http://www.winnpsb.org/dhs/troubleshooting/bct.htm Provides a list of hardware and software 
tips including what to do if the keyboard or mouse stops working. 
http://www.everythingcomputers.com/troubler.htm Provides links to several other trouble-
shooting guides, some of which are specifically for Windows 98. 
 

http://www.computerhope.com/basic.htm
http://www.winnpsb.org/dhs/troubleshooting/bct.htm
http://www.everythingcomputers.com/troubler.htm
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Additional Internet Resources: 
Educational 
www.the-underdogs.com A free software site that also has an educational software section. Most 
of the software in this section is old, but there are a few classics like Number Munchers that can 
be useful. 
http://teacher.scholastic.com/technology/ A website with ideas on how to integrate technology 
and computers into an existing curriculum 
 
HTML Guides 
The following are a list of HTML guides that offer descriptions of the basic HTML tags that were 
used to create the shell for Central Academy’s computer curriculum page. 
www.davesite.com/webstation/html/
http://archive.ncsa.uiuc.edu/General/Internet/WWW/HTMLPrimerAll.html
http://www.w3.org/MarkUp/Guide/
 
Misc. Resources 
www.google.com Good for just about everything, Google can be used for searching for a variety 
of things including coloring pages for art, layouts for WebPages, technology-planning resources 
and specifically for pictures. 
http://teacher.scholastic.com/tools/ Offers a web tool to help develop a class homepage. 
www.download.com download.com offers thousands of downloads including games, computer 
utilities, and educational software. 
www.giftsinkind.org This website offers a variety of discounted items for non-profits included 
Windows XP. 

http://www.the-underdogs.com/
http://teacher.scholastic.com/technology/
http://www.davesite.com/webstation/html/
http://archive.ncsa.uiuc.edu/General/Internet/WWW/HTMLPrimerAll.html
http://www.w3.org/MarkUp/Guide/
http://www.google.com/
http://teacher.scholastic.com/tools/
http://www.download.com/
http://www.giftsinkind.org/


Appendix B: 
This is a screen capture of a preliminary website created for Central Academy. 
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